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OPENING THIS PACKAGE CONSTITUTES ACCEPTANCE OF THIS AGREEMENT 
PLEASE READ THIS AGREEMENT BEFORE OPENING THIS PACKAGE

IF THIS AGREEMENT IS NOT ACCEPTABLE, PLEASE CONTACT RPG AT 301-249-0044 (in USA) OR RETURN THIS PACK-
AGE, UNOPENED, TO THE PLACE WHERE YOU OBTAINED IT, FOR A FULL REFUND

END USER SOFTWARE LICENSE AGREEMENT

Terms and Conditions

1. DEFINITIONS.
As used in this Agreement, the following terms shall have the meanings set forth below:
1.1   "RPG” means RPG Diffusor Systems, Inc.
1.2 "Customer" means the original end-user of the software.
1.3 "Designated Computer" means a single computer designated by the Customer. One licensed copy of the Software is required
for each computer system that the Software is used on.
1.4 "Software" means the RPG Room Optimizer™ Software Product, regardless of the form in which Customer may subsequently
use it or them, and regardless of the modifications that may be made to it or them. As used herein, Software includes all documen-
tation and other written materials relating to the Software provided.

2. LICENSE.
2.1 Subject to the terms and conditions of this Agreement, RPG hereby grants Customer a non-exclusive, non-transferable right to
use the Software on the Designated Computer and to make one copy of the Software as a backup.
2.2 The license granted under this Agreement authorizes the Customer to use the Software in executable form solely on the
Designated Computer. Only one user may have access to the Software at any time. A separately licensed copy of the Software is
required for any additional computer.
2.3 Customer shall not have the right to sublicense the Software. Customer shall not have the right to print, copy, reproduce, dis-
tribute, modify or in any other manner duplicate the Software, in whole or in part. Customer shall not decompile, disassemble or
otherwise reverse engineer the Software or any part thereof. Customer shall not have the right to obtain or use any source code
for the Software.
2.4 Customer understands that unauthorized reproduction or transfer of the Software may be a crime, and would subject Customer
to damages and attorneys fees.

3. SUPPORT.
3.1 Any support services provided by RPG, including but not limited to, installation and training services, shall be provided on a
time and materials basis at RPG's then current prices, subject to the availability of RPG's resources to provide such services.

4. NO WARRANTY.
4.1 RPG EXPRESSLY DISCLAIMS ANY WARRANTY FOR THE SOFTWARE. THE SOFTWARE AND ANY RELATED DOCU-
MENTATION ARE PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING,
WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR
NON-INFRINGEMENT. The entire risk arising out of use or performance of the Software remains with Customer. No employee,
agent, dealer or distributor is authorized to make any warranties or modify the foregoing disclaimer of warranties. If implied war-
ranties may not be disclaimed under applicable law, then any implied warranties are limited in duration to thirty (30) days after the
date of Customer’s initial use of the Software. Some states do not allow limitations on how long an implied warranty may last, so
the above limitation may not apply to Customer. Further, neither RPG not its licensors warrant, guarantee, or make any represen-
tations regarding the use, or the results of the use, of the Software in terms of correctness, accuracy, reliability, currentness, or oth-
erwise. Customer assumes the entire risk as to the results and performance of the Software. RPG's obligation with respect to
support shall be solely as provided in Article 3.
4.2 With respect to infringement or misappropriation, Customer's sole and exclusive remedy shall be as provided in Section 7.3
hereof.
4.3 IN NO EVENT SHALL RPG OR THE DISTRIBUTORS, SUPPLIERS, LICENSORS, RESELLERS OR MANUFACTURERS OF
RPG PRODUCTS, INCLUDING THE SUPPLIERS OR DISTRIBUTORS OF PRODUCTS WITH WHICH THE SOFTWARE MAY BE
BUNDLED, BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, CONSEQUENTIAL, OR PUNITIVE DAMAGES WHATSO-
EVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION,
LOSS OF BUSINESS INFORMATION OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OR INABILITY TO USE
THE SOFTWARE OR OTHERWISE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

5. PROPRIETARY RIGHTS.
5.1 Customer acknowledges that ownership of the Software, including all intellectual property rights therein and all modifications
thereof, is and shall remain in RPG or its licensors. Customer acquires only the rights to use the Software expressly granted here-
in and does not hereby acquire any other rights of ownership in the Software. RPG or its suppliers own all title and copyrights in
and to the Software, the accompanying printed materials, and any copies of the Software. You may not copy the printed materials
accompanying the Software. RPG reserves all rights not specifically granted by the Agreement.
5.2 Customer agrees to reproduce and include any copyright or other proprietary notices included in the Software on all copies, in
whole or in part, in any form, including partial copies of the Software.



5.3 RPG represents and Customer acknowledges that the Software is proprietary to RPG or its licensors and includes copyrighted
works, trade secrets and may include software for which patents have been applied for or issued. Customer may disclose the
Software to its employees, representatives and contractors only on a need-to-know basis and shall obtain written confidentiality
agreements from third parties. Customer will hold the Software in confidence and safeguard it from disclosure to third parties,
unauthorized reproduction and use and access by third parties. Customer agrees not to provide or disclose the Software in any
form, including, but not limited to, program listing, object code, or source code.
5.4 Customer shall not provide or permit public access to the Software in whole or in part, including, but not limited to, by comput-
er networks, periodicals, newspapers or any other accessible or distributed media.
5.5 Customer agrees to take all reasonable steps to insure that the terms and conditions of this Agreement are made known to
anyone who uses the Software. Customer agrees to insure that all materials that could lead to the use of the Software in a man-
ner that violates this Agreement will be erased or destroyed, when they are no longer needed.

6. DURATION.
6.1 This Agreement is effective from the date the Customer receives the software and shall remain in force until terminated.
6.2 Customer may terminate this Agreement at any time by destroying the Software together with all copies, modifications and
merged portions in any form and giving notice thereof to RPG.
6.3 Either party may terminate this Agreement if the other party materially breaches a provision of the Agreement and fails to cor-
rect the breach within 30 days following written notice of the breach. Upon such termination, Customer shall destroy the Software
together with any and all copies, modifications and merged portions in any form and certify the same to RPG.
6.4 Customer's obligations of confidentiality hereunder and to make payments as provided herein and RPG's obligations of confi-
dentiality hereunder shall survive any termination hereof.

7. INDEMNIFICATION.
7.1 As an express condition to the use of the Software, Customer agrees to indemnify and hold RPG and its licensors harmless
from all claims by third parties rising out of Customer's use of or modifications to the Software.
7.2 Neither RPG not its licensors shall have any liability for any claim of infringement based on (a) use of superseded or altered
release of the Software if such infringement would have been avoided by the use of a current unaltered release previously made
available to Customer by RPG or (b) the combination of operations or use of any Software furnished under this Agreement with
software or other components not supplied by RPG if such infringement would have been avoided by the use of such Software
without such other components.
7.3 In the event that the Software is held to violate the proprietary rights of third parties, or RPG reasonably believes such a hold-
ing is possible, RPG shall have the option, at its expense to (a) modify the Software to be noninfringing, (b) to obtain for Customer
a license to continue using the Software or (c) refund any license fee paid to RPG for the Software.
7.4 Section 7.3 states RPG's entire liability for infringement or other violations of proprietary rights.

8. GENERAL.
8.1 If any of the provisions or portions thereof, of this Agreement is invalid under any applicable statute or rule of law, they are to
that extent to be deemed omitted and the balance of this Agreement shall remain in full force and effect.
8.2 This is the complete and exclusive Agreement between RPG and Customer and supersedes all proposals, oral or written, and
all other communications between the parties relating to the subject matter of the Agreement. This Agreement may not be modi-
fied orally.
8.3 This Agreement shall be governed by and interpreted in accordance with the substantive laws of the State of Maryland.
8.4 The waiver by either party of any default or breach of this Agreement shall not constitute a waiver of any other or subsequent
default or breach.
8.5 The Software, including copies an any medium, are to be used for the sole and exclusive benefit of Customer and for no other
entity. Customer may make no assignment or delegation of any right or duty under this Agreement without the express prior writ-
ten consent of RPG. Any prohibited assignment or delegation shall be null and void for all purposes.
8.6 All notices hereunder shall be in writing and shall be deemed given on the fifth business day after being sent by certified or
registered mail or on the date of delivery if sent by other means.

9 DUAL-MEDIA SOFTWARE.
9.1 You may receive the Software in more than one medium. Regardless of the type or size of medium you may receive, you may
use only one medium that is appropriate for the Designated Computer. You may not use or install the other medium on another
computer. You may not loan, rent, lease, or otherwise transfer the other medium to another user.

10 EXPORT CONTROLS.
10.1 You may not export or re-export the Software or any underlying information or technology, except in full compliance with all
United States and other applicable laws and regulations. In particular, but without limitation, you may not export the Software or
underlying information or technology to or for a resident or national of Cuba, Haiti, Iraq, Libya, Yugoslavia, North Korea, Iran, Syria,
or any other country to which the Unites States embargoed goods; or to anyone in the United States Treasury Department's list of
Specially Designated Nationals or the United States Commerce Department's Table of Deny Order. By using the Software, you are
agreeing to the foregoing and you are representing and warranting that you are not located in, nor under the control of, or a nation-
al or resident of any such country or on any such list.
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A new approach to automated optimized listener/loudspeaker placement 

Room Optimizer™ is a Windows 95™ program to help determine the opti-

mum locations for listener and loudspeakers in a rectangular room. The theo-

ry behind the program is detailed in the accompanying White Paper in the

Appendix.

There have been various approaches that suggest room dimensions and the

positioning of listeners, loudspeakers, and acoustical treatment within a

room. Most of these are relatively simple calculations, which were developed

when powerful desktop computers did not exist. With the computational

desktop power now available, more sophisticated positioning and evaluation

algorithms can be used. The need for a new optimized approach grows as we

move from stereo to 5.1 multi-channel music and home theater digital sur-

round formats. In these new musical delivery formats, the room design and

loudspeaker/listener placement become much more complex. For example, in

a typical 5.1 home theater you may have to determine the best location for

the listener, 5 full range loudspeakers, multiple sub-woofers, plus absorptive

and diffusive room treatment. Room Optimizer™ is a novel coupling of mod-

ern room acoustics prediction techniques with iterative multi-dimensional

optimization methods. The pro-

gram carries out an automated

search for the best positions for

listener and low-frequency loud-

speakers (woofers) in a rectan-

gular room. 

The flow chart indicates the iter-

ative process. First, a random set

of listener and loudspeaker loca-

tions is evaluated by calculating

the energy impulse response via

an image model. The image

model is an efficient method to

find all specular reflections from

a source to a receiver. It converts 1

What is Room Optimizer™?1

Please read the
white paper in the

Appendix for a more
thorough discussion
of the scientific prin-
ciples used in Room

Optimizer™  
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the problem of a source reflecting from boundaries to an equivalent problem

involving multiple mirror image sources and no boundaries. Then two FFTs

are performed on the impulse response to reflect the transient and long term

aspect of the way we perceive music. A windowed 65 ms short-term FFT of

the low-order reflections determines the speaker boundary interference

response. A long-term FFT of the entire windowed impulse response extend-

ing to many orders (15 is the default) gives the ‘modal’ response. It is

assumed that the best room response is obtained when the speaker-boundary

interference and modal response spectra are smoothest and flattest. The even-

ness of the spectra are evaluated by taking a weighted sum of the standard

deviation of each response over the low frequency range, typically between

20-300 Hz. If the error is below the tolerance set for the optimization then

the program ends. If the error is above the tolerance, the optimization enters

a simplex search routine which suggests the next best trial locations. These

locations are then evaluated in a similar manner until the error is below toler-

ance. In this way the program finds locations in the room that are the best for

reproduction of sound at low frequencies. In those instances in which there is

no opportunity to change the listener or loudspeaker positions, you can use

the RoomOptimizer™ to evaluate the room and suggest the locations of

acoustical surface treatment.

Acoustic Distortion
The interactions among listener, loudspeakers and room boundaries may pro-

duce what we call Acoustic Distortion. Loudspeakers used for sound repro-

duction in recording studios, listening rooms and home theaters are designed

in many ways. These consist of forward-firing dynamic monopoles, dipoles

(spatially displaced drivers out of polarity with each other), bipoles (spatially

displaced drivers in polarity with each other) and “multi-poles”. Electrostatic

and ribbon dipole speakers can also be used. This wide range of speakers

provide directivities ranging from directional to omnidirectional. When the

coverage pattern is wide enough for the emitted sound to reflect off the room

boundaries, interference effects occur between the direct sound and the

reflected sound and the listener then experiences the combined result of this

interference. At low frequencies, where all loudspeaker types are omnidirec-

tional, this interference manifests itself as a speaker-boundary interference

and modal resonances. The magnitude of both is related to the locations of

the listener and the loudspeakers and how they couple with the room’s pres-

sure response. Thus the first and least expensive thing to optimize in a sound

reproduction room is the low frequency response. RoomOptimizer™ allows

you to automatically and optimally locate the listener and woofer positions.
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Acoustical Treatment
Low Frequencies

Following optimal placement, you may wish to further improve the low fre-

quency response by adding acoustical treatment. Most porous absorbing

materials like fiberglass and foam have limited efficiency in the 20-300 Hz

range, especially near a boundary surface where the particle velocity is low.

Therefore, effective low frequency absorption can be obtained using an

absorption mechanism that relies on the pressure, since the pressure is high

near a room boundary. This can be accomplished using membranes or porous

pressure-gradient trapping near walls where two room surfaces meet or in

corners where three room boundary surfaces meet.  Additionally, if the

room’s dimensions are such that the low frequency modal resonances are

excessive and additional help is needed, or if physical relocation of the

woofers is not possible or desired aesthetically, then electronic equalization

in the modal frequency range may be the only other approach. If done prop-

erly, this can be effective.

Mid/High Frequencies

At mid/high frequencies the interaction between direct and reflected sound,

when plotted on a linear frequency axis, takes the form of a severely notched

response, like the teeth of a comb. This effect is appropriately called comb

filtering. Comb filtering occurs across the entire frequency spectrum and is

responsible for degrading the location and apparent size of sonic images, as

well as the perceived frequency response. In general, electronic equalization

of the mid/high frequency response is not advised, because in attempting to

minimize problems associated with room reflections, you destroy the one

thing which is good: the direct sound. Thus, the only choices you have are to

limit the coverage of the loudspeakers so they do not interact with the walls

or acoustically treat the boundary surfaces. Since all loudspeakers interact

with the room in some portion of their frequency spectrum, appropriate

acoustical room treatment seems the appropriate choice. RoomOptimizer™

indicates the locations of the first bounce positions for all loudspeakers from

all boundary surfaces. At the moment these locations are for the low frequen-

cy woofers, however, these locations are close to those of the mid and high

frequency loudspeakers and can be used as a general guide. If the mid and

high frequency drivers are located above the woofers, as is usually the case,

simply extend the height of the acoustical surface treatment wall coverage by

the necessary amount above the geometrical reflection positions of the

woofers. Ceiling treatment will extend closer to loudspeakers and floor treat-

ment, if desired, will extend closer to the listener.
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System requirements
The program requires a reasonable quality computer running Windows95™.

The calculations are not particularly memory intensive, but are time consum-

ing and will benefit from a Pentium PC or equivalent and 16 MB of RAM or

more.

Installation and getting started
Room Optimizer™ is supplied on CD ROM.  If you do not have a CD ROM

drive, please contact RPG and we will supply a disk.  Place the CD ROM

into the drive.  Select “Run” from the Start menu on the task bar.  Run the

program Setup.exe from the CD ROM and follow on-screen instructions. You

will be prompted for your Name, Company and Serial Number.  The Serial

Number is very important and can be found on the enclosed registration card.

Please keep track of this number after you return the registration card,

because you will be asked to supply it for all upgrades and additions that

may be made available via the internet.  Room Optimizer™ will automatical-

ly install and create the necessary program groups.  In addition, uninstall rou-

tines will be placed on the computer should you wish to remove the program.

These can be run from the Add/Remove Programs icon found in the Control

Panel.  The Install program places the program in the default directory

C:\Program Files\RPG Diffusor Systems Inc\Room Optimizer.  To run the

program, select Start from the task bar, then Programs and double click on

the Room Optimizer icon.  To create a shortcut, go to the directory

C:\Program Files\RPG Diffusor Systems Inc\Room Optimizer, select

roomoptimizer.exe with the mouse, select File and Create Shortcut.  The

Shortcut can then be dragged and dropped on the desktop for future use.

Several room configuration files are supplied in C:\Program Files\RPG

Diffusor Systems Inc\Room Optimizer\Examples.  These can be loaded from

the File menu once the program is started.  

Limitations
The current version of Room Optimizer™ is restricted to rectangular

(cuboid) rooms, with highly reflective surfaces. The optimization will sug-

gest placement for the listener, loudspeakers and acoustical surface treatment.

The application of acoustical surface treatment will improve on the results

indicated in the Spectra screen. Many additional features are envisioned for

future versions. 

When viewing the SBIR and Modal response spectra do not be alarmed if

Room Optimizer™
is easily installed

from CD, using the
familiar Install

Shield.
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your room does not optimize to a flat line. This is impossible, because there

will always be some degree of interference between the loudspeakers and

their boundaries and all rooms have modal resonances. The objective is to

minimize the standard deviation or average squared deviation from the ideal

flat response as seen in the Error Parameter Progress Graph. Different loca-

tions for listener/loudspeakers will affect different frequencies in different

ways. RoomOptimizer™ searches all of the possible locations in the room

and finds the one that produces one of the best overall combined spectra in

the room. You will notice that the best result has a significantly lower error

than the worst result encountered during the search for the optimum solution.

The program does not also search for the absolute worst result, which would

make the comparative improvement even greater. Version 1.0 can accommo-

date 20 independent and 20 dependent loudspeakers. 

RPG DIFFUSOR SYSTEMS INC. DISTRIBUTES THIS SOFTWARE AS

IS, WITHOUT LIABILITY OR GUARANTEE REGARDING THE

EFFECTS OF USING THE PROGRAM AND THE RESULTS OBTAINED.
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Starting Room Optimizer™ will introduce you to a new approach in deter-

mining the optimum acoustical design of your listening room. Using power-

ful image model and search algorithms, Room Optimizer™ determines the

optimum placement for the listener, loudspeakers, and acoustical room treat-

ment. The system is implemented as a Windows 95® package.

This manual provides a brief description of the operation and capabilities. We

have arranged this manual so that you can easily add 8 1/2” x 11” pages from

optimization printouts and Worksheets, web site downloads of new configu-

rations, versions, etc. and as a reference for articles related to the subject of

room optimization. An in-depth white paper is also provided in the

Appendix. After loading the program, you will be asked for a name for the

licensed program user. “Please enter the name of the company or person who

purchased Room Optimizer™”. The name you enter will be listed on the

headers of all printouts. 

The quickest way to familiarize yourself with the program is to run it. This

Quick Tour provides a quick overview of the program’s main features. Room

Optimizer™ is supplied with a pre-defined room configuration for a stereo

loudspeaker pair. Begin the optimization of this stereo pair by selecting

Start from the Actions menu. If the screen display, colors or wallpaper

make it difficult to view the screen, then you can edit these from the

Preferences sub-menu of the Edit menu. While the program is running,

explore all of the different screens in the View menu. Examine the

listener/loudspeaker locations and error in the Data view, the listener/loud-

speaker locations in the Room view, the speaker-boundary interference and

modal response in the Spectra view, the listener/loudspeaker room configura-

tion in the Configuration view, the Wizard view is not until you open a

Wizard as described later, the first order reflection points in the GRP view

and the Error parameter progress graph in the Error view. You can either pre-

maturely Stop the optimization from the Actions menu, or wait for the pro-

gram to find an optimum solution. This is indicated by a message box. You

can now go to the File menu to Print any of the View screens, Save
results to file or Save configuration for later optimization. 

Quick Tour2

Select Start from
the Actions menu.
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RoomOptimizer™ comes with pre-defined configurations for all of the wiz-

ards. To complete this Quick Tour, try Load configuration from the File
menu. Pick one of the configurations stereo (stereo1w.roi), stereo with 2

woofers/cabinet (stereo2w.roi), left/center/right (lcr.roi), subwoofer

(sub1.roi), 5.1 multichannel music with 5 matching speakers (mcm.roi), or

5.1 THX®* with Left/Center/Right and dipole surrounds (THX.roi). Start

the optimization of one of these room configurations by selecting Start from

the Actions menu. As before, select the Data, Room, Spectra, or

Configuration screen. When the optimization is finished you can Print,

Save results, or Save configuration from the File menu. 

To speed usage of the RoomOptimizer™, you can use the shortcut key com-

binations. To accomplish this, hold down the specified combination of ALT,

CTRL and/or SHIFT keys with the underlined letter.  Thus you can select

any of the main menu items by using the mouse or the ALT + underlined let-

ter keys. For example, to select the File menu, press and hold ALT + F, from

the main screen. Hitting the ALT key alone will clear any pull down boxes.

Once a pull down menu is available, you can select any of the options by hit-

ting the desired underlined letter. For example, after selecting the View menu

by holding ALT + V, hitting the E key selects the Error parameter progress

graph. You can also directly select main menu options by hitting the indicat-

ed shortcut key strokes from the main screen. For example, you can choose

the Error parameter progress graph directly from the main screen by pressing

and holding CTRL+SHIFT+E. 

*THX® is a registered trademark of Lucasfilm, LTD.  

Select
Load configuration

from the File menu.

Read the menu
descriptions in

sequence or as
needed

Select ALT+
underlined menu

letter for short cut
keys..
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Now that you have experienced the main features in this Quick Tour, we will

describe the details of the View screens, how to Edit an existing configura-

tion, or Define a new one with or without the assistance of room Wizards.

Then we will describe the details of printing, saving, and loading pre-defined

room configurations and exiting the program. The Appendix contains an

advanced white paper describing the theory behind RoomOptimizer™. 

While the optimization is in progress you can choose different views from

the View menu to evaluate the process.

View
Data

shows how the error parameter, used to gauge the quality of the spectra, is

changing. The lower the error parameter, the flatter the spectra. The errors for

the solutions of the best value so far, worst value so far and last computed

value are listed. This screen also indicates the number of solutions found and

the listener and loudspeaker locations for the best solution thus far. All dis-

tances are measured from the front left lower corner where the floor meets

the left and front wall. 

View Menu3

The View menu 
allows the main

window to toggle
between different

information windows.

Select Data, 
Room, Spectra,
Configuration,

Wizard, GRP, Error
from the View menu.
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View
Room

shows a drawing of the room in the form of a plan, front and side elevation.

The worst, best and current positions of the listener and loudspeakers are

indicated in the colors chosen with Edit � Preferences � Colors. The

geometric reflection points on the walls, ceiling and floor are also shown as

colored arrows (>) for the best solution. The colors for absorption, diffusion

and absorption/diffusion mirror the colors for worst, best and current posi-

tions. These indicate optimum placement for diffusing or absorbing material

to control first order reflections. The listener position is indicated by a box

and the loudspeakers are indicated by a diamond symbol. 
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View
Spectra

shows the Speaker-Boundary Interference Response (SBIR) and the Modal

Response for the worst, best, and current positions. The SBIR reflects the

coherent interference between the direct sound and first order reflections. The

Modal Response reflects the room’s standing waves. The program attempts to

find the listener and loudspeaker locations with the flattest combined spectra.

More details
of the criteria

used to gauge
the quality of

spectra is given
in the enclosed 
scientific paper.
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View
Configuration

gives a display of the settings that define and limit the optimization.  These

include the room dimensions, the listener location range, number of indepen-

dent (ILS) and dependent loudspeakers (DLS), limits for the independent

loudspeaker positions, symmetry constraints between independent and depen-

dent loudspeakers, stereo constraint and minimum listener-loudspeaker

approach distance. More details on setting your own configurations is given

later in this document.
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View
Wizard Information

is used to simplify the creation of room configurations. After one is selected,

a Wizard Information screen can be accessed that details what the wizard has

done. The screen shows the listener and independent loudspeaker search lim-

its. It also describes the symmetry and displacement constraints relating the

independent and dependent loudspeakers. The stereo angular constraint and

the minimum listener/loudspeaker approach distance are also listed. 
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View
Geometrical Reflection Point (GRP) Data

lists the geometrical reflection points associated with the first-order reflec-

tions of the woofers. These points are indicated by colored arrows (>) on the

side elevation, plan view and front elevation of Room View. The GRP data

are sorted according to these three views and further sorted by boundary, i.e.

front, side and rear wall, ceiling and floor. The type of acoustical treatment is

also suggested. Remember all coordinates are referenced to the lower left

front corner.  x is the distance from the front wall, y is the distance from the

left wall and z is the distance above the floor. 
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View
Error

displays a plot of the error versus iteration number.  The error is the com-

bined standard deviation of the speaker-boundary interference and modal

responses. It gives the user a good sense of the improvement the program is

achieving. In the graph below the program has found 4 solutions. At the

beginning of each search, the program assigns random starting points. Hence

the initial large error. As the program optimizes the listener/loudspeaker posi-

tions the error can be seen to decrease. When a solution is found, the error

plot rises again, because the program assigns initial random starting points

for the next cycle. In this example, the program was asked to confirm solu-

tions. Thus the second iteration process starts with a lower error, because the

initial points are only slightly different from the previous solution which was

found. After the second solution, the program assigns random starting points

and the error rises once again. After the third solution is found, it is con-

firmed as evidenced by the last section of the plot. Note that the Room

Optimizer™ found the best of the four solutions at the end of the second iter-

ation cycle.
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Edit
Preferences

has several options for changing the appearance of the program. This can

also be accessed by clicking the right mouse button while the cursor is over

the program window. 

Edit
Preferences

Metric units
allows you to choose between meters and feet and inches. 

Edit
Preferences

Display
The Display sub-menu allows you to choose a Color, White on black or

Black on white display. You may wish to switch to Black on white for

screen captures and printing. If part of the display is missing check that the

window for the application is maximized. The program display works best

with a maximized window.

Edit
Preferences

Colors
The Colors sub-menu allows you to choose the Background color, Best
spectra color, Text color, Worst spectra color, Current spectra
color, RPG logo color, and Frequency grid. If the default color scheme

makes it difficult to see the chosen view, the configuration may be changed. 

Edit
Preferences

Font
The Font option allows you to select the font. The font size selected is for

the normal text size- that used for the data display for example.

Edit
Preferences

More wallpaper

Edit Menu4
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The More wallpaper sub-menu allows you to select between more or less

wallpaper. If the wallpaper interferes with the view chosen, you can select

less wallpaper. 

Edit
Preferences

Frequency grid
The Frequency grid sub-menu allows you to choose whether or not to dis-

play a grid in the Spectra view.

Edit
Preferences

Save Preferences
To store your choices for the display preferences, select the option Save
Preferences, otherwise the settings will be lost when you exit the program. 

Edit
Whole configuration

If you are starting a new configuration, you may find that one of the wizards

can be used to simplify the process of defining the configuration. If there is

something about the current room configuration, such as room dimensions,

search ranges, constraint relationships between independent and dependent

loudspeakers, etc., that you would like to change, you can do so from the

Edit Menu. If necessary, stop the optimization by choosing the appropriate

item from the Actions menu. By choosing Whole configuration you

can page through all of the edit screens to modify any aspect of the configu-

ration that you wish, before re-starting the optimization. 

Room dimensions
The first edit screen you encounter is the room dimensions. You can edit

these in feet and inches or meters. If

you choose feet and inches, you can

enter the dimensions as decimal feet,

e.g. 18.5’, or in feet and inches, e.g.

18’ 6”, or all inches 222”. If the foot

symbol (’) is omitted, the program

assumes the number is in feet, e.g. 18

is the same as 18’. When using metric

units, no unit identifier is used and all

dimensions must be in meters. 
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Listener search limits
The next edit screen contains minimum and maximum positions for the lis-

tener, along the room’s length or x-direction, across the front wall or width,

the y-direction, and the height, the z-direction. The coordinates displayed for

the listener represent the center of the head. When the listener is on the cen-

ter line of the

room, the actual

receiver position

used in the calcu-

lation is dis-

placed 10 cm

(3.94”) from the

center line. This

then represents

the position of

one ear. By including a small displacement from the center line, the program

allows for the slight differences in the sound that arrives at the ears of the lis-

tener. The program uses the front lower left corner as the origin. That is, all

distances are measured from the front left lower corner, where the floor

meets the front and left wall facing the loudspeakers. The optimum solution

for the listener

position may be

in a location that

is not practically

or ergonomically

acceptable. By

using these

search limits, you

can instruct the

program to find a

solution in a

physically acceptable rectangular volume. Use the mouse or Tab key to move

from box to box. You can move to the next screen or back to the previous

screen if you want to correct a previous entry. Or you can cancel the edit.

The data is read and stored when Next is selected. If Back is selected, the

entry is not updated. 

Room Optimizer™ allows you to examine the existing configuration or vary

the x, y or z coordinates. For example, if the minimum and maximum posi-

tion are different, the program will find the optimum location. However, if
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the minimum and maximum position in the x, y or z direction are the same,

then Room Optimizer™ will maintain that position. For example, if the mini-

mum and maximum listener z coordinate are both set to 3’ 8.9”, then the pro-

gram assumes that the listener’s ear height is fixed. However, if you are shop-

ping for a favorite chair, you may ask Room Optimizer™ to search for the

best ear height, within the limits of your chair selections. In general the y-

direction is set to the center of the width of the room to maintain symmetry.

If there is a reason this is not desired, you can also vary the y-direction mini-

mum and maximum. The minimum and maximum x direction can be set to

coincide with desired positions for a sofa or recording console. The program

also allows you to set a stereo angular constraint, which maintains the ratio

of the distance from the speaker plane to the listener and the speaker separa-

tion between specified limits. If the ratio is set to 0.88, for example, the lis-

tener will lie at the apex of an equilateral triangle determined by the two

loudspeakers and the listener. This constraint is accessed from the Define �

Advanced menu described later in the manual. 

Number of loudspeakers
In any multidimensional optimization, there will be many good solutions that

the program can find. To reduce the complexity of the optimization and to

insure that one of the best solutions is

found, the program divides the number

of loudspeakers into independent and

dependent types. The locations of all

independent loudspeakers are actually

varied. The locations of all dependent

loudspeakers are determined from the

positions of the independent loud-

speakers. A simple example will illus-

trate this difference. In a typical stereo

listening room configuration, the left front loudspeaker can be selected as the

independent loudspeaker. Because the right speaker is related by mirror sym-

metry across the plane running down the center of the room (the xz plane),

its position is dependent on where the left independent speaker is located.

Thus we can simplify the optimization by only varying the left loudspeaker.
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Independent loudspeaker limits
As with the Listener limit ranges, you can select search limits for all of the

independent loudspeakers. In this way you can customize the search to find

the best solution within the rectangular volumes which are physically accept-

able for each independent loudspeaker. For example, if there is a door way or

a structural column you need to avoid, you can simply set the x, y and z min-

imum and maximum limits appropriately. 

In the upper right hand corner of this screen you will notice a Name combo

box that allows you to name the independent loudspeaker from a selection

list or to type in a new name. For example, left front or right rear. 

Also next to the minimum and maximum limit boxes you will find x, y and z

check boxes which allow you to constrain the x, y, or z distance of each inde-

pendent loudspeaker to either the x, y or z coordinate of the listener. The

power of this feature can best be explained by considering the rear dipole

speakers in a THX surround configuration. In this arrangement, the listener is

typically located at the null of the dipoles. Thus as the optimization proceeds,

it would be useful to constrain the left rear dipole’s x position to follow the x

position of the listener. In this way, regardless of the listener’s x distance,

he/she will always be in the null of the dipole. 

For floor standing loudspeakers, you may wish to fix the z coordinate at its

actual distance above the floor. In other cases, if you are designing or pur-

chasing a stand, you may wish to vary the z coordinate to find the best height

for the stand. Please bear in mind that you may have to make a trade off

between optimal woofer height for good bass response and optimal

mid/tweeter height for good imaging. Life is a series of compromises!

If you have set the search limits for each independent loudspeaker, you can
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go to the next screen (Dependent driver positions) and edit the symmetry or

displacement relationships between the dependent loudspeakers and the inde-

pendent loudspeakers they are related to. If you choose to go back and edit a

previous screen you may do so by choosing Back. You can also Cancel the

editing session.

Dependent driver positions
In the upper right Name dialog box you can select a name for the dependent

driver from the pull down menu or enter a name of your choice. You must

also enter the number of the independent driver that controls the position of

the selected dependent driver. To change the number of the independent dri-

ver simply click in the dialog box with the mouse and enter the desired inde-

pendent driver number.

There are 4 additional rectangular dialog boxes. On the left side of the screen

you have the x, y and z displacement constraints and the 180 degree out of

phase check box. 

Displacement
When there are more than one woofer in a loudspeaker cabinet, you can

select one as the independent loudspeaker and the others as the dependent

loudspeakers. To accomplish this you can set the x, y or z displacement of

each dependent woofer from the independent one. For example, in a two

woofer loudspeaker in which the woofers are vertically displaced by 18”, you

would enter 18” or 1.5’ in the z dialog box. this will insure that as the inde-

pendent lower woofer varies, the upper constrained dependent woofer will

accompany it, only displaced by 18” vertically. 



21

180 Degrees out of phase
If one of the dependent woofers is out of phase with the independent woofer,

you can select this check box. 

On the right side of the screen you have the x, y and z check boxes for mirror

symmetry constraints and the radio buttons which determine whether the mir-

ror plane is with respect to the listener or the room center. You can also select

the center front constraint which maintains that the dependent loudspeaker

will be restricted to be on the center line of the room, equidistant between the

left and right front and, and also maintained at the same vector distance as

the independent speaker it is controlled by. 

Mirror symmetry
Mirror symmetry is an effective means of relating independent and depen-

dent loudspeakers. If you are unfamiliar with this concept, place your left and

right hand on a flat surface. The right hand is the mirror image of the left

about the line (or plane perpendicular to the flat surface) separating the two.

In a similar way the right speaker and left speaker are mirror images of each

other about the vertical plane passing through the center of the room. Thus,

two parameters

need to be speci-

fied: the direc-

tion which is

affected by the

mirror symmetry

and the plane or

mirror which is

being used. The

distance is deter-

mined by select-

ing the appropriate check box and the mirror is determined by the listener or

room center radio button. In our stereo example, you would select the y

check box for the right dependent loudspeaker and the room center radio but-

ton. If the listener is located off the room centerline, then select Mirror about:

Listener (default setting), so the Y-Mirror follows the listener. 

You would select the listener as the mirror symmetry plane when describing

dependent rear loudspeakers. For example, in the emerging multi-channel

music 5.1 room configuration that uses 5 matching loudspeakers, you can

constrain the left rear speakers to be a mirror image of the left front about the
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x plane passing through the listener. The right rear can be constrained by two

mirror planes: one x plane about the listener and another about the y room

center. Then, as the left front speaker is varied, the left rear and right rear

will move with the appropriate symmetry relationships to the independent

front left speaker. 

Center front loudspeaker
The use of a center loudspeaker is gaining popularity in home theater config-

urations, because this allows multiple listeners to hear the dialog from the

center of the screen as opposed to a movable phantom center image. Room

Optimizer™ allows you to choose this center loudspeaker as an independent

loudspeaker or a dependent Center Front Loudspeaker. When you choose the

Center Front Loudspeaker check box, you insure that the left/center/right

front loudspeakers lie on a circle with the listener at the center. This choice

makes the arrival times from all front loudspeakers equal. 

You can now go Back to a previous screen, go to the Next dependent speak-

er or Cancel the editing session.
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Configuration
After all dependent loudspeakers are edited you will be presented with the

Configuration screen from which you can examine all of the changes that

were made. At this point you may wish to go to the Actions menu and

Start the optimization using this new configuration. You can also go to the

File menu and Save configuration for future use. You will be prompted

to save the configuration filename in a standard Windows 95™ dialog box. 
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The new configuration won’t run
If the configuration is defined so that there are no possible starting points for

the optimization, the program will inform you of this via the message “The

optimization routine has failed to find any suitable starting points”?. Errors

may be generated either during data entry or the optimization process.  A

couple of common causes of such problems are:

The displacement of a dependent loudspeaker from an independent loud-

speaker puts the dependent loudspeaker out of the room.

The stereo constraints, which put limits on the angle subtended by the loud-

speakers at the listener, can not be obeyed within the defined listener and

loudspeaker volumes. More details on setting the stereo constraints is given

in the Advanced Options section.  Also please see the FAQ section on page

43.

Troubleshooting
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You have three ways to obtain a desired room configuration. You can Load a

previously defined configuration from the File menu and edit it if necessary,

you can choose a pre-defined Wizard configuration and edit if necessary or

define a completely new room configuration. To define a new room configu-

ration, you use the Define menu.

Define 
New configuration

Under the Define menu, the New configuration option allows you to

define a new room configuration. The new room configuration can be deter-

mined from a set of pre-defined room wizards or experienced users can

choose to define the new room without the help of the pre-defined wizards. 

Use Wizards
You will be warned that the existing room configuration will be lost. It is

suggested that new users select an appropriate wizard radio button, which

best fits the desired room configuration. The new room configuration is

entered via a series of dialog boxes that prompt you for the necessary input. 

The first screen requests the room dimensions. Following this, in all cases

except the stereo with multiple woofers, you will see the Wizard Information

screen. You can review this screen to determine if this is the room configura-

tion you want to optimize. If so you can Start the optimization from the

Define Menu5

Pre-designed Wizards
allow you to quickly define
a new room configuration.
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Actions menu. If not, you can Edit
the Whole configuration. In the

case of the multiple woofer Wizard

you will also be prompted for the

number of woofers in each cabinet and

the displacement between their cen-

ters. In the case of the subwoofer

Wizard, you will be prompted for the

desired frequency range of the opti-

mization. Remember, the origin of the room and the location from which all

distances are measured, is in the front lower left corner. The arrows in the

Room view reflect this. 

Don’t Use Wizards
Essentially the program will prompt you for input with all of the same

screens you have already experienced in the Whole configuration. The

flow chart on page 31 illustrates the steps necessary to define a new room

configuration from the Define � New configuration menu. You will be

prompted to enter the room dimensions, the listener search limits, the number

of independent (ILS) and dependent loudspeakers (DLS), the ILS search lim-

its and symmetry/displacement relationships, and the DLS symmetry/dis-

placement relationships. At this point you can review the room configuration,

Edit if necessary, and Save the room configuration for future use. You can

then run the optimization, Print and Exit the program if you have the

answer you were looking for. 

The most efficient way to design a new room configuration is to fill out the

Room Optimizer Worksheet. You will find a blank Worksheet in the

Examples section of this manual. Please make as many photocopies as you

wish and place them in the Examples section for future use. This manual is

designed as a Workbook, so you can conveniently add 8 ½" x 11" inserts of

Worksheets, RoomOptimizer™ printouts, downloaded website updates, white

papers, etc. 

To describe how to design a new room configuration, we will use a surround

sound example. The loudspeaker configuration consists of front left and right

loudspeakers each containing two vertically displaced woofers separated by

13.5", a center channel woofer, two dipole surrounds mounted on the side

Define a new room 
configuration not provided

by a Wizard or a previously
saved configuration.

Up to 20 woofers can be 
optimized. The more

woofers , the longer the
optimization time.



27

REVIEW CONFIGURATION

EDIT IF NECESSARY

LISTENER SEARCH LIMITS (X,Y,Z)

PRINT/SAVE RESULTS

EXIT PROGRAM

NUMBER OF LOUDSPEAKERS (ILS + DLS) EXAMPLE: 3ILS + 6DLS = 9 TOTAL LS

ROOM CONFIGURATION

ROOM DIMENSIONS (L,W,H)

INDEPENDENT DEPENDENT

Symmetry and displacement
constraint relationships

DLS 2

ILS 3 DLS 6

ILS 2 DLS 5

ILS 1 DLS 1

•Search Limits
•Symmetry and displacement

constraint relationships

SAVE CONFIGURATION

START/STOP

DLS 3

DLS 4
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Independent Dependent

WOOFERS

ROOM DIMENSIONS LENGTH: WIDTH: HEIGHT:

LISTENER
SEARCH LIMITS

X MIN:
X MAX:

Y MIN:
Y MAX:

Z MIN:
Z MAX:

ILS CONSTRAINTS CONSTRAINTS

Variables Search limits

X MIN - X MAX Y MIN - Y MAX Z MIN - Z MAX DLS

LLF 1 2’-6’ 1.5’-3.5’ 15”

ULF 1 Z= +13.5”

LRF 2 Y-Mirror

URF 3 Y-Mirror + Z= 13.5”

C Center Channel 4 Z= +35”

DLS 2 Listener X Listener 4” 6.5’-8’

DRS 5 Y-Mirror

RLS 3 15’-17’ 1.5’-4’ 3’-6’

RRS 6 Y-Mirror

19’

My room 1/1/2000

8.5’
13’

7’
7’

42”
42”

14’ 10’



29

walls opposite the listener's position and left and right dynamic surround rear

loudspeakers. 

We have filled in the Project Name (My Room), Date (1/1/2000) and Room

Dimensions (Length = 19', Width = 14' and Height = 10'). Remember, all

dimensions are measured from the front, left, lower corner. X is the distance

from the front wall, Y is the distance from the left wall and Z is the height

above the floor. 

Listener
The only information you need to enter for the listener is the Listener Search

Limits: xmin-xmax, ymin-ymax, zmin-zmax. These define the rectangular

volume within which you will search to find the optimum location for the lis-

tener's ears. In most cases, you will place the listener on the room's center-

line, where the y coordinate equals half the room's width. When you enter the

same number for ymin and ymax, you are indicating to the

RoomOptimizer™ that this position should be fixed and not optimized. On

the Worksheet we entered xmin-xmax = 8.5 - 14', ymin-ymax = 7' and zmin-

zmax = 42". Thus the middle of the listener's head is fixed on the room cen-

terline at y= 7' and at a seated height above the floor of 42". Room

Optimizer™ will search for the best distance from the front wall between 8.5'

and 14'. 

Woofers
We begin by simply naming all of the woofers. The lower and upper woofers

in the left front loudspeaker (LLF) and (ULF), the two woofers on the right

side of the room's centerline, i.e. the lower right front (LRF) and the upper

right front (URF), the center loudspeaker ( C ) sitting on the rear projection

monitor, the left and right dipole surrounds (DSL) and (DSR) and finally the

left and right front-firing dynamic rear surrounds (RSL) and (RSR). For the

sake of this example, let's assume that between 80 and 300 Hz the two

dipoles mounted against the wall act as a hemispherical point source so we

can treat them as one. We have listed a total of 9 woofers, which we will dis-

tribute into independently varying loudspeakers (ILS) and dependently vary-

ing loudspeakers (DLS). 

Independent loudspeaker 1- ILS1 (LLF)
Consider the relationships between the left, center and right front woofers. If

we identify the position of the LLF woofer, we can immediately identify the

positions of the remaining 4 woofers. The ULF is 13.5" above the LLF. The

LRF is a mirror image of the LLF about a y mirror located on the room's
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centerline at half the width. The URF is located by a mirror of the LLF about

the room's centerline and a vertical displacement of 13.5" in z. The center

loudspeaker ( C ) will also be controlled by ILS1 as well, by constraining the

center loudspeaker-listener distance to be equal to the LLF-listener distance.

This insures that the arrival time between the left, center and right speakers

will be equal. 

Now lets number the ILSs and the DLSs. We can define the LLF as the first

independent loudspeaker. The other 4 front drivers can be determined from

this. Thus the LLF is ILS1 and the other four front woofers are DLS1, DLS2,

DLS3 and DLS4. Enter a 1 in the Worksheet in the ILS column next to LLF

and 1, 2, 3 and 4 under DLS in the ULF, LRF, URF and C rows, respectively.

Notice that the ILS and DLS numbering is independent and runs from 1 to

the number of independent and dependent speakers. The total number of

woofers is simply the sum of the number of independent and dependent

woofers. To review, dependent loudspeakers DLS1, DLS2, DLS3 and DLS4

are related to independent loudspeaker ILS1. 

ILS1 (LLF) Constraint
Since the front left and right speakers will be floor standing, the height of the

front 4 woofers will be fixed in Z. The LLF woofer is fixed at 15" above the

floor and therefore, zmin and zmax will be set at 15". 

ILS1 (LLF) Search limits
The LLF woofer will be allowed to vary between 2' and 6' from the front

wall, 1.5 - 3.5' from the left wall and is fixed at a height of 15" above the

floor. 

Independent Loudspeaker 2- ILS2 (DSL)
If we locate the dipole surround left (DSL) we can also determine the dipole
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surround right (DSR) by a y mirror image about the room's centerline. Thus

DSL is ILS2 and the DSR is DLS5.

ILS2 (DSL) Constraint
The x coordinate of ILS2 will be constrained to the x coordinate of the lis-

tener, so that the listener can be positioned in the null of the dipole directivity

pattern. This is an example of a dynamic constraint. As the listener's x coor-

dinate moves though the Listener Search Limits, the x coordinate of the DSL

will follow. 

ILS2 (DSL) Search Limits
ILS2 will be constrained in x to the listener and also attached directly to the

wall so that the center of the woofer array is about 4" from the wall. The

height above the floor will be allowed to vary between 6.5' (to clear the head

of people walking by) and 8'. 

Independent Loudspeaker 3- ILS3 (RLS)
In the rear of the room we will optimize the location of the rear surrounds. If

we locate the RLS we can determine the position of the right rear surround

(RRS) by a y mirror about the room's centerline. Thus (RRS) will be DLS6.

ILS3 (RLS) Constraint
The x search range will begin beyond the maximum listener search limit, so

the side dipoles and rear surrounds do not get too close. This can be modified

in a subsequent optimization, once you gain an idea of where the optimum

listener position is located. 

ILS3 (RLS) Search Limits
Since the rear surrounds can be mounted on stands, we will search in z as

well as x and y. The z coordinate can be used to determine the most appro-

priate height of the stand for good low frequency response. 

DEPENDENT LOUDSPEAKERS
The dependent loudspeakers aare related to the independent loudspeakers by

symmetry and displacement constraints. 

DLS1 (ULF)- The upper front left woofer (ULF) is related to the ILS1

(LLF) woofer by a vertical displacement or translation of 13.5".

DLS2 (LRF)- The lower right front loudspeaker (LRF) is related to ILS1

(LLF) by a y mirror image about the room's centerline. 

Dependent loud-
speakers are relat-
ed to the indepen-
dent loudspeakers
by symmetry and

displacement con-
straints..
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DLS3 (URF)- The upper right front loudspeaker (URF) is related to ILS1

(LLF) by a y mirror image about the room's centerline and a vertical transla-

tion of 13.5".

DLS4 (C)- The center woofer (C) is related to the ILS1 (LLF) by the center

loudspeaker constraint, which maintains equal distances between the listener

and the left/center/right front loudspeakers. In this example the center loud-

speaker will be placed on top of a rear projection monitor, so its height will

be fixed. To place the center woofer 50" above the finished floor, we intro-

duce a 35" z translation above the 15" height of the LLF woofer along with

the center loudspeaker constraint.

DLS5 (DSR)- The dipole surround right (DSR) is related to ILS2 (DSL) by a

y mirror image about the room's centerline. 

DLS6 (RRS)- The rear dynamic surrounds (RRS) is related to ILS3 (RLS)

by a y mirror image about the room's centerline. 

Now that we have the Worksheet filled out, we can transfer the data into the

RoomOptimizer™. Select Define � New configuration from the menu

bar. You will be prompted that the "Existing room configuration will be lost".

Select OK to continue. You will see the "Define new configuration" screen

with a list of Wizards and the Don't use Wizards option. Select the Don't use

Wizards radio button and hit OK. You will be prompted for the room dimen-

sions. Enter them in feet and inches (default) or meters. Use the tab key to

advance to the next entry box. After you have entered the x, y and z room

dimensions, hit NEXT to advance to the Listener limits screen or CANCEL

the room configuration definition. The minimum and maximum x, y and z

boxes refer to the xmin-xmax, ymin-ymax, and zmin-zmax entries on the

Worksheet. Transfer the information using the Tab key to advance to the next

entry box. If you enter a number without feet (') or inches (") unit markers,

the numbers will be interpreted as feet. If you enter a compound dimension,

such as 8' 6", you need to enter the ' and " units. If you enter just inches, such

as 15", you must enter the " units or the program will interpret the number as

feet. When you are finished you can go BACK to correct a previous error, go

to the NEXT screen or CANCEL the room configuration definition. 

The next screen prompts for the number of independent drivers (ILS) and

dependent drivers (DLS). Count the number of ILS and DLS from the

Worksheet and enter the respective totals into the appropriate boxes. You can
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then go BACK, advance to the NEXT screen or CANCEL the room configu-

ration definition. The next screen prompts input for the independent driver

search limits. These are the xmin-xmax, ymin-ymax and zmin-zmax limits

you entered on the Worksheet for the ILSs. At the top RoomOptimizer™ will

indicate the specific independent driver, e.g. ILS1, ILS2, ILS3, etc. You can

Name the driver with a convenient user-defined name or choose from the pull

down menu. Enter the name LLF assigned to ILS1 in the Worksheet. We will

not need to constrain ILS1 to any listener x, y or z coordinate. For ILS1 enter

2' for the minimum and 6' for the maximum x search limits, 1.5' and 3.5' for

the minimum and maximum y coordinate search limits and 15" for the mini-

mum and maximum z coordinate. By selecting NEXT you will be prompted

for the Search limits for ILS2. You can enter DLS for the name of ILS2 using

the Name pull down menu. Then transfer the search limits from the

Worksheet into the appropriate boxes. The x coordinate will be constrained to

the listener's x coordinate by checking the minimum and maximum x boxes

under "Constrain to Listener". The y coordinate will be fixed at 4" by enter-

ing 4" as the minimum and maximum value, and the minimum and maxi-

mum z value should be entered as 6.5' and 8', respectively. Select NEXT to

advance to the entry screen for ILS3. Enter the name RLS in the Name pull

down menu. The x search limits will be between 15' and 17', so as not to

interfere with the side dipoles. The y coordinate will vary between 1.5' and

4'. The z coordinate will vary between 3' and 6', so we can determine an

appropriate stand height. 

Select NEXT to advance to the Dependent drive position (DLS) entry screens.

This is where the Worksheet will be especially helpful. You will have to relate

the appropriate DLS numbers with the appropriate ILS numbers. For example,

DLS1, DLS2, DLS3 and DLS4 are controlled by ILS1, DLS5 is controlled by

ILS2, and DLS6 is controlled by ILS3. First name the DLS1 as ULF in the

Name pull-down menu. Then enter a "1" in the box next to the prompt

"Dependent driver controlled by position of independent driver number". This

means that DLS1 is controlled by ILS1. Enter 13.5" for the z coordinate in the

Displaced by: sub-entry box. Since DLS1 is not 180 degrees out-of-phase with

respect to ILS1 do not check this box. Check the NEXT button to advance to

the entry screen for DLS2. Enter LRF for the Name and enter "1" next to the

prompt for the ILS which controls DLS2. DLS2 is obtained from ILS1 by a y

mirror about the room center. Select Mirror image in: Y-axis box and room

center radio button. If you enter zero or a larger number than the number of

ILS entered earlier, you will get an error "Cannot identify independent loud-

speaker". Select NEXT for the entry screen for DLS3. Enter the Name URF
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and enter "1" for ILS1 as the controlling independent loudspeaker. Select the

Mirror image in: Y-axis, room center radio button and also enter 13.5" for the z

displacement in Displaced by: Select NEXT to enter information for DLS4.

Name this driver C and enter "1" for the controlling ILS. Now select Center

Front Loudspeaker box to indicate that this center channel and the LLF will be

equidistant from the listener . Select NEXT to advance to DLS5. Enter the

Name DSR and enter "2" as the controlling ILS. Select Mirror image in: Y-axis

box. Select NEXT to advance to the last dependent loudspeaker screen DLS6.

Enter RRS as the Name and select the Y-axis box in Mirror image in:

The next screen will display the Configuration for review. Look it over to

verify the data entries. If there is an error, select Edit � Whole configu-
ration and advance through the screens in order making appropriate correc-

tions. Once the corrections are made, you can select Actions � Start to

begin the optimization. 

Define
Advanced

Error parameter calculation
This option allows the relative importance of the SBIR and Modal Response

to be varied. Increasing the percentage error due to the SBIR will mean the

optimization will take more notice of how flat the SBIR is when it tries to

find the best positions in the room.

Define
Advanced

Frequency range
The Frequency range of the optimization can be varied. This might be

useful if a sub-woofer system is being optimized. This should be run as a

separate optimization from the left/center/right speakers which cover a differ-

ent frequency range.

Define
Advanced

Number of solutions
The Number of solutions can be varied. With any multi-dimensional

optimization procedure every solution given by the program may not be the

global minimum - the best possible positions in the room. By carrying out

more trials it is more likely that the global minimum will be found. In our

experience, Room Optimizer™ tends to find several solutions that are equal-
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It is suggested 
that the repeatable

starting positions
menu item is

unchecked.

It is suggested
that the extreme

starting positions
menu item is

checked.

ly good and have similar error parameters. By asking for more solutions you

may get a larger number of good positions to choose from, but it takes longer

to optimize. If you check the Confirm each solution box, you will get

twice the number of solutions selected, because each solution is confirmed

by re-optimizing from locations close to the solution.

Define
Advanced

Extreme starting positions
When this menu item is checked, it forces the starting loudspeaker and listen-

er points to be near to the edge of the volumes which define possible loud-

speaker and listener position. This helps the optimization program to carry

out a thorough search of all possible positions.

Define
Advanced

Repeatable starting positions
Every time a particular configuration is tried, the starting points for the opti-

mization are chosen at random. In the case where there are a variety of good

positions in the room, this may mean that the optimization solutions will be

different each time the program is run. It is possible to ask for Repeatable
starting positions by checking this menu item.

Define
Advanced

Simplex termination criteria
The Simplex termination criteria sets the criteria that the optimization

routine uses to determine when a solution is found.

Define
Advanced

Stereo constraints
The Stereo constraints has two options. It enables:

1. the minimum distance between the listener and any loudspeaker to be set.

2. the setting of the angle subtended by the loudspeakers at the listener to

ensure proper stereo imaging. The stereo constraints are in terms of the ratio

of the distance from the listener to the center line between the loudspeakers

and the separation of the loudspeakers. This option can only be applied to

independent loudspeaker 1.

It is recommended
that the option to
confirm solutions 

is used unless time
is a premium.
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Define
Advanced

Frequency based Modal calculations
In a rectangular room the spectra can be calculated via the impulse response

or an exact frequency overlap modal calculation. For perfectly reflective

room boundaries the two approaches are equivalent as described in the

accompanying White Paper in the Appendix. This option allows the opti-

mization to use the frequency based calculation. This option is not recom-

mended, unless you have a sufficiently fast processor, as it is much slower

than the impulse response approach. The frequency based approach can also

be used to calculate the modal response of a room configuration by inserting

room dimensions and fixed locations for listener and loudspeakers. 
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File
Save results (CTRL + S)

The program enables the results from the optimization to be saved to a

comma delimited text file. This text file can be imported into most spread

sheets for publication quality spectra plots and further analysis. In Microsoft

Excel, for example, open the saved file and choose “delimited” as the

Original data type. Then select “comma” delimited. The data are then avail-

able for plotting and analysis. 

The saved file includes the following information:

The configuration for the optimization

And for each solution:

The best and worst error parameter values

The SBIR and ‘Modal” response for the best and worst positions

And for the best position:

The co-ordinates of the listener and loudspeakers

The locations of the geometric reflection points.

The Save results option can be selected before the optimization is started or

after it has ended. Before beginning the optimization you are presented with a

Save all results and configuration dialog box and an option to Save Results?

and Set Filename. After an optimization comes to a natural or user-terminated

completion the Save results dialog box offers you the choice to save results

from the previous terminated run or the next run that will be initiated. 

Making a screen capture
In addition to the Save results feature which allows you to prepare publi-

cation quality graphics, you may wish to include screen views as illustrations

in report documents or proposals.

Windows 95™ allows you to capture the active screen and place it on the

clipboard. This image can be pasted into the Windows Paint program or other

image editing software to create bitmap images. You can also use dedicated

screen capture utilities which allow you to save the images in various file for-

mats. As a suggestion, our experience indicates that *.tif works well for

images and *.eps works best with professional Postscript publishing pro-

File Menu6
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grams such as Quark Express or Pagemaker.

To capture a color screen view to the clipboard, make sure the window you

want is active, hold down the Alt key and press the Print Screen (PrtScrn)

key. The image is pasted onto the clipboard, although you will not be given

any indication of this. To paste the image into Windows Paint program, open

the program from the Windows Accessories folder and Paste the image from

the edit menu. To save the entire image as a new *.bmp file, select Copy To

from the edit menu, and choose a destination filename.

Dark color screens may prove a problem when the images are included into

documents and printed in black and white. Therefore, you may wish to select

Black on white as the Display color from the Edit � Preferences
menu prior to hitting Alt + PrntScrn.

File 
Load configuration

You can load pre-defined configurations, from the File menu. The load con-

figuration dialog box prompts you for the “filename.roi”. 

File
Save configuration As

Any configuration that you set up in the RoomOptimizer™ can be saved

using the Save configuration As option of the File menu. The Save
configuration As filename prompts you for the file name. You can use

this option to save different room configurations, consisting of different

dimensions, different loudspeakers, different listener and loudspeaker search

limits, and different displacement and mirror symmetry conditions.

File
Print (CTRL + P)

You can print any or all of the seven View screens from the Print option.

From the Print Screens dialog box you can choose the print font, the print

color, the screens desired, and a check box which only prints the best solu-

tion information on the room and spectra view. 

File
Printer Setup

The Printer Setup dialog box allows you to choose the desired printer.
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File
Exit (ALT + F4)

The Exit sub-menu allows you to exit the program. Alternatively you can

use the close window cross in the top right corner of the window. If your

results have not been saved, you will be prompted with an Exiting program

dialog box. 
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We begin the Workbook section with some example room configurations for

you to experiment with and a blank RoomOptimizer™ Worksheet for you to

photocopy. On your RoomOptimizer™ program disc there are also some

sample configuration initialization files (*.roi) that you can load from the file

menu and run. When you create a new room configuration it will be useful if

you file the Wooksheet here and save the configuration for future use. 

Workbook7
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ILS# ILS NAME CONSTRAINTS DLS# DLS NAME CONSTRAINTS

1 Left None 1 Right Y Mirror about room center

1 Lower left None 1 Upper left Z Displacement

2 Lower right Y Mirror

3 Upper right Y Mirror + Z Displacement

1 Lower left None 1 Upper left front baffle Z Displacement

front baffle 2 Lower left rear baffle X Displacement + or - polarity

3 Upper left rear baffle X and Z Displacement + or - polarity

4 Lower right front baffle Y Mirror about room center

5 Upper right front baffle Y Mirror plus Z Displacement

6 Lower right rear baffle Y mirror plus X Displacement

7 Upper right rear baffle Y mirror plus X and Z Displacement 

1 Left None 1 Right Y Mirror about room center

2 Center Equal left front listener distance

1 Left front None 1 Right front Y Mirror about room center

2 Center front Equal left front listener distance

2 Left dipole rear Constrained to listener X 3 Right rear Y Mirror about room center

1 Lower left front Z height fixed 1 Upper left front Z Displacement

2 Lower right front Y Mirror

3 Upper right front Y Mirror plus Z Displacement

2 Center left Z Displacement from lower left 4 Center right Y Mirror about room center

3 Left dipole rear Constrained to listener X 5 Right dipole rear Y Mirror about room center

1 Left front None 1 Right front Y Mirror about room center

2 Center front Equal left front listener distance

3 Left rear X Mirror about listener

4 Right rear X and Y Mirror about listener

1 Left front None 1 Right front Y Mirror about room center

2 Center front Equal left front listener distance

2 Left rear X Limit starts at listener max X 3 Right rear Y Mirror about room center

STEREO

STEREO
with 2 woofers.

STEREO
with 4 woofers

per loudspeaker:
2 in front baffle

and 2 in rear.

STEREO
with 1 woofer plus 

center loudspeaker.

5.1 THX
with dipole surround.

5.1 THX
with 2 vertically

displaced front woofers,
2 horizontally displaced
center speaker woofers

and dipole surrounds.

5.1
multichannel music

with 5 matching
speakers

5.1
multichannel music

with 5 matching
speakers



42

Independent Dependent

WOOFERS

ROOM DIMENSIONS LENGTH: WIDTH: HEIGHT:

LISTENER
SEARCH LIMITS

X MIN:
X MAX:

Y MIN:
Y MAX:

Z MIN:
Z MAX:

ILS CONSTRAINTS CONSTRAINTS

Variables Search limits

X MIN - X MAX Y MIN - Y MAX Z MIN - Z MAX DLS
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Frequently Asked Questions
Q. Why does the listener/woofer optimize at one of the search limits?

A. If the listener or woofer positions are optimized at the extreme positions

of the search range, then you may wish to increase this range and repeat the

optimization. RoomOptimizer™ is attempting to locate the listener/woofer

outside its allowed range. 

Q. What point of the woofer do I use to measure from?

A. The answer is the acoustic center, which is that imaginary point from

which all sound originates. In practical terms, the center of the woofer can be

used to determine the height above the floor and the distance from the left

wall. The distance from the front wall is less obvious. The acoustic center of

a woofer varies with the woofer. As a rule of thumb, however, measure to the

face of the dust cap (the dome at the bottom of the woofer cone). 

Q. Do you have a Macintosh version?

A. Sorry, we do not.

Q. Will there be future upgrades?

A. Yes. RPG intends to continue the development of RoomOptimizer™ to

include several new features: rectangular room dimension optimization, mul-

tiple listening positions, non-rectangular room shape, etc. 

Q. If I repeat an optimization using the same room configuration I do not get

the same answer.

A. In a multi-dimensional optimization there are many good answers.  Each

answer is valid.  You can select among several solutions by either choosing

the lowest error or the most ergonomically desirable configuration.  

Q.  How do I interpret the error message “A dependent loudspeaker moved

too close to the listener or a room boundary”?

A.  This error may arise when a center loudspeaker is constrained to be at an

equal distance from the listener as the left/right speakers.  The center loud-

speaker may be closer to the front wall than the left/right independent speak-

er, thus triggering the error.  The solution is to increase the minimum X limit

Appendix8
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for the independent speaker, which in turn moves the center loudspeaker

away from the front wall.  

Q.  How do I interpret the error message “The optimization routine has failed

to find any suitable starting points”?

A.  The program uses a stereo angular constraint to insure that the listener is

located at an appropriate distance from the loudspeakers for good stereo

imaging.  The listener search range is forcing the listener outside these limits.

The solution is to change the listener limits or disable the stereo angular con-

straint (Define/Advanced/Stereo Constraints).

Q.  Why am I experiencing problems printing in color?

A.  Problems with printing in color are usually due to the way in which the

Win95 API interprets the colors on the screen. The dark background is inter-

preted as white, white line do not show up, and yellow lines are very faint.

A simple solution is to reverse the color scheme. Set the background to be a 

light color and the text and lines to be dark colors. Don't forget to save pref-

erences so the color scheme reappears when the program reloads.

Q.  Can I resize the program window during optimization?

A.  Resizing issues are dealt internally by Win 95.  We have experienced

some lockup during resizing, so we suggest resizing before beginning opti-

mization.  

Please send in your questions to info@rpginc.com or fax to 301-249-3912

and we will add them to this list. You will also be able to consult

www.rpginc.com for a listing of FAQ by other users and download new room

configurations. 

Troubleshooting
If you encounter problems when operating the program, it helps in tracking

down the cause if the following information is given:

1. Brief details of the computer the program is being run on,

2. A description of the problem,

3. The configuration file for the optimization causing problems (if applicable),

4. A sample of the saved output file. 

Send inquiries to info@rpginc.com or fax to 301-249-3912
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